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PREFACE

This manual explains how to use the RCC Controller.

Copyright© 2014 Horner APG, LLC, 59 South State Avenue, Indianapolis, Indiana 46201. All rights
reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language or computer language, in any form by any means, electronic,
mechanical, magnetic, optical, chemical, manual or otherwise, without the prior agreement and written
permission of Horner APG, Inc.

All software described in this document or media is also copyrighted material subject to the terms and
conditions of the Horner Software License Agreement.

Information in this document is subject to change without notice and does not represent a commitment on
the part of Horner APG.

Ethernet™ is a trademark of Xerox Corporation.
MicroSD™ and CompactFlash are registered trademarks of SanDisk Corporation.

For user manual updates, contact Technical Support:

North America:

Tel: (+) 1-877-665-5666

Fax: (+) (317) 639-4279

Web: http://www.heapg.com
Email: techsppt@heapg.com

Europe:

Tel: (+) 353-21-4321-266

Fax: (+) 353-21-4321-826

Web: http://www.horner-apg.com
Email: tech.support@horner-apg.com
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LIMITED WARRANTY AND LIMITATION OF LIABILITY

Horner APG, LLC, ("HE-APG") warrants to the original purchaser that the RCC controller module
manufactured by HE-APG is free from defects in material and workmanship under normal use and
service. The obligation of HE-APG under this warranty shall be limited to the repair or exchange of any
part or parts which may prove defective under normal use and service within two (2) years from the date
of manufacture or eighteen (18) months from the date of installation by the original purchaser whichever
occurs first, such defect to be disclosed to the satisfaction of HE-APG after examination by HE-APG of
the allegedly defective part or parts. THIS WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER
WARRANTIES EXPRESSED OR IMPLIED INCLUDING THE WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR USE AND OF ALL OTHER OBLIGATIONS OR LIABILITIES AND HE-APG
NEITHER ASSUMES, NOR AUTHORIZES ANY OTHER PERSON TO ASSUME FOR HE-APG, ANY
OTHER LIABILITY IN CONNECTION WITH THE SALE OF THIS RCC module. THIS WARRANTY
SHALL NOT APPLY TO THIS RCC module OR ANY PART THEREOF WHICH HAS BEEN SUBJECT
TO ACCIDENT, NEGLIGENCE, ALTERATION, ABUSE, OR MISUSE. HE-APG MAKES NO
WARRANTY WHATSOEVER IN RESPECT TO ACCESSORIES OR PARTS NOT SUPPLIED BY HE-
APG. THE TERM "ORIGINAL PURCHASER", AS USED IN THIS WARRANTY, SHALL BE DEEMED TO
MEAN THAT PERSON FOR WHOM THE RCC module IS ORIGINALLY INSTALLED. THIS WARRANTY
SHALL APPLY ONLY WITHIN THE BOUNDARIES OF THE CONTINENTAL UNITED STATES.

In no event, whether as a result of breach of contract, warranty, tort (including negligence) or otherwise,
shall HE-APG or its suppliers be liable of any special, consequential, incidental or penal damages
including, but not limited to, loss of profit or revenues, loss of use of the products or any associated
equipment, damage to associated equipment, cost of capital, cost of substitute products, facilities,
services or replacement power, down time costs, or claims of original purchaser's customers for such
damages.

To obtain warranty service, return the product to y our distributor with a description of the
problem, proof of purchase, postpaid, insured and i n a suitable package.

ABOUT PROGRAMMING EXAMPLES

Any example programs and program segments in this manual or provided on accompanying diskettes are
included solely for illustrative purposes. Due to the many variables and requirements associated with any
particular installation, Horner APG cannot assume responsibility or liability for actual use based on the
examples and diagrams. It is the sole responsibility of the system designer utilizing the RCC controller
module to appropriately design the end system, to appropriately integrate the RCC controller module and
to make safety provisions for the end equipment as is usual and customary in industrial applications as
defined in any codes or standards which apply.

Note: The programming examples shown in this manual are for illustrative purposes only.
Proper machine operation is the sole responsibility of the system integrator.
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Visual map of major tasks and key chapters
FIRST STEP of ANY TASK: DATASHEET |

on information.

Each RCC unit is sent with a datasheet in the box. The datasheet (MAN0971-02-EN) is the
first document to refer to for model-specific infor
pin-outs, jumper settings, and other key installati
datasheets, manuals and user documentation, visit a Horner website (US:

http://www.heapg.com and Europe: http://www.horner-apg.com.)

mation related to RCC models such as

To obtain updates to

QUICK START INSTALLATION PROGRAMMING TROUBLESHOOTING
Safety / Safety / Compliance Safety / Compliance Safety / Compliance
Compliance page 10 page 10 page 10
page 10
Introduction Introduction Introduction Introduction
page 12 page 12 page 12 page 12
Mechanical Serial Maintenance
Installation Communications page 45
page 15 page 19
Electrical CAN Troubleshooting
Installation Communications page 45
page 17 page 20
Ethernet
page 22
Removable Media
page 27
General 1/0
page 30
Cscape Config
page 33
Registers
page 41
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CHAPTER 1: SAFETY / COMPLIANCE

1.1  Safety Warnings and Guidelines

When found on the product, the following symbols specify:

A |Warning: Consult user documentation. | {g\ | Warning: Electrical Shock Hazard.

WARNING — EXPLOSION HAZARD - Do not disconnect equipment unless power has been switched off
or the area is known to be non-hazardous

WARNING: To avoid the risk of electric shock or burns, always connect the safety (or earth) ground before
making any other connections.

WARNING: To reduce the risk of fire, electrical shock, or physical injury it is strongly recommended to fuse
the voltage measurement inputs. Be sure to locate fuses as close to the source as possible.

WARNING: Replace fuse with the same type and rating to provide protection against risk of fire and shock
hazards.

WARNING: In the event of repeated failure, do not replace the fuse again as a repeated failure indicates a
defective condition that will not clear by replacing the fuse.

WARNING — EXPLOSION HAZARD - Substitution of components may impair suitability for Class |,
Division 2

WARNING - The USB parts are for operational maintenance only. Do not leave permanently connected
unless area is known to be non-hazardous

WARNING — EXPLOSION HAZARD - BATTERIES MUST ONLY BE CHANGED IN AN AREA KNOWN
TO BE NON-HAZARDOUS

WARNING - Battery May Explode If Mistreated. Do Not Recharge, Disassemble or Dispose Of In Fire

a. All applicable codes and standards need to be followed in the installation of this product.
b. For I/O wiring (discrete), use the following wire type or equivalent: Belden 9918, 18 AWG or
larger.

Adhere to the following safety precautions whenever any type of connection is made to the module.

a. Connect the green safety (earth) ground first before making any other connections.

b. When connecting to electric circuits or pulse-initiating equipment, open their related breakers. Do
not make connections to live power lines.

c. Make connections to the module first; then connect to the circuit to be monitored.

d. Route power wires in a safe manner in accordance with good practice and local codes.

e. Wear proper personal protective equipment including safety glasses and insulated gloves when
making connections to power circuits.

f.  Ensure hands, shoes, and floors are dry before making any connection to a power line.

g. Make sure the unit is turned OFF before making connection to terminals. Make sure all circuits
are de-energized before making connections.

h. Before each use, inspect all cables for breaks or cracks in the insulation. Replace immediately if
defective.
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1.2  Grounding

Grounding is covered in various chapters within this manual.

1.3 Compliance

To check for compliance and updates, visit the Horner website (US: http://www.heapg.com or
Europe: http://www.horner-apg.com.)

Page 10 of 47




I HORNER

AUTOMATION GROUP

CHAPTER 2: INTRODUCTION

2.1 Visual Overview of RCC

Power/CAN/RS485 Connector

USB A
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microSD slot Port1 Port2
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CARD
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Depth: 1.411"

I
(35.84mm) 4.567" (116mm)

Field 1/0 Connector

Figure 2.1 — Overview of the RCC2414

RCC User Manual

USB mini-B

Ethernet Port 1

Ethernet Port 2
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CAN and Digital Output Power Port

Digital Outputs

WCCO98 7654321
|

CAN & EXT PWR DIGITAL OUTPUTS

RUN/STOP
LOAD

MEMORY Ethernet Port

DC DIGITAL INPUTS

7B 910MZ13W | ‘-f-_.E

eSS ssSssss=aE o & Serial Port

|
(35.84mm) 4 567" (116mm)
Digital Outputs
Figure 2.2 — Overview of the RCC1410
Where to Find Information about the RCC

a) Datasheet - The datasheet is the first document to refer to for key information related to
specific RCC models.

a. The datasheets for all RCC models are available on the Horner websites.
b. Datasheets contain pin-outs and other model specific information.

b) User Manual -This manual provides general information that is common to RCC models and
can be downloaded from our web. Visit the Horner website (US: http://www.heapg.com or
Europe: http://www.horner-apg.com) to obtain user documentation and updates.

Four main types of information are covered in this manual

a) Safety and Installation guidelines / instructions (Mechanical and Electrical)
b) Descriptions of hardware features
a. (Serial ports, Removable Media, Communication Options, etc.)
c) Configuration and Use of the RCC
d) Maintenance and Support
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2.1.3 Manual Index
Major topics of interest may be found in the Index towards the end of this manual.
2.2 Connectivity to the RCC

The RCC has excellent capabilities for connecting to a variety of devices. The diagram below
shows some examples of devices that can be used with the RCC.

Other Control Other Control
Devices CAN Serial Devices
Smart Stix I/O <::.> \'/‘::> Drives
RCX116 I/O Base PLCs
OPC Server Bar Code Readers
RCC Printers
SCADA
| Ethernet OPC Servers
\ Serial I/O
ndicators 10 e
: = OPC Server
Alarms Modbus TCP Devices
Encoders
Pumps
Relays
Solenoids

2.3 Features of RCC

The RCC are industrial control devices with built in I/O. They combine control, I/O, and networking into a
single, integrated package. Unique features of the RCC include:

- Advanced control capabilities including floating point, multiple auto-tuning PID loops and string
handling capabilities.

- Removable media for 32GB of storage of programs, data logging, and on-site updating.

- CsCAN networking port for communication with remote 1/O, other controllers or PCs.

- Configurable serial protocols for communication to drives, PLCs, or other serial peripherals.

- Advanced high speed I/O capabilities

- Cscape programming software that allows all aspects of the RCC to be programmed and
configured from one integrated application.

- On board Ethernet port (10/100Mbps) for Cscape programming and application defined
communication, with Auto MDI/MDI-X.

- Small, compact, din-rail mountable logic controller with flexible built in I/O

2.4 Required and Suggested Accessories

The following list contains a sampling of required and suggested RCC accessories. Visit the Horner
websites to view updates on new products and accessories.
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NOTE: The RCC is not shipped with a programming cab  le in the box. To obtain a programming
cable, order HE500CBL300.

Table 2.1 — RCC Accessories

Part Number Description

HE-XCK Programming cables, including a USB to serial adapter in a travel case.

25 Useful Documents and References

The following information serves as a general listing of Horner controller products and other references of
interest with their corresponding manual numbers. Visit the Horner websites to obtain user documentation
and updates.

Table 2.2 — CONTROLLER Reference Document numbers

NOTE: This list is not intended for users to determine which products are appropriate for their application; controller products
differ in the features that they support. If assistance is required, refer to Technical Support.

Manual Description Manual Number

Datasheet for RCC model MAN1032
User Manual for XLe/XLt OCS models MANO0878
User Manual for RCC/RCCe OCS models MAN

User Manual for XL4 OCS models MAN0964

User Manual for QX Series models MANO798

User Manual for NX Series models MANO0781

User Manual for XL7 OCS models MAN0974

User Manual for ZX OCS Models MAN1018
Other Useful References Manual Number

CAN Networks MANO0799

Spark Quenchers for Arc and Noise Suppression (output protection) MAN0962

Wiring Accessories and Spare Parts Manual MANO0347

Ethernet Communications SUP0740
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CHAPTER 3: MECHANICAL INSTALLATION

Note: The datasheet is the first document to refer to for information related to RCC
models such as pin-outs, 1/O and general specificat ion, and other key installation
information . Visit the Horner websites to obtain datasheets, user documentation, and updates.

3.1 Overview

The mechanical installation greatly affects the operation, safety, and appearance of the system.
Information is provided to mechanically install the unit such as cut-out sizes, mounting
procedures and other recommendations for the proper mechanical installation of the unit.

3.6.3 Temperature / Ventilation

Ensure that the DIN Rail layout design allows for adequate ventilation and maintains the specified
ambient temperature range. Consider the impact on the design if operating at the extreme ends of the
ambient temperature range. For example, if it is determined that a cooling device is required, allow
adequate space and clearances for the device in the panel box or on the panel door if DIN rail is mounted
inside.

3.6.4 Orientation
RCC should be mounted with locking DIN Tab facing down.

3.6.5 Noise

Consider the impact on the panel layout design and clearance requirements if noise suppression devices
are needed. Be sure to maintain an adequate distance between the RCC and noisy devices such as
relays, motor starters, etc.

For details on output protection, especially when using contactors, solenoids see MAN0962-01-EN.

3.6.6 Shock and Vibration

The RCC has been designed to operate in typical industrial environments that may inflict some shock and
vibration on the unit. For applications that may inflict excessive shock and vibration please use proper
dampening techniques or relocate the RCC to a location that minimizes shock and/or vibration.
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CHAPTER 4: ELECTRICAL INSTALLATION

Note: The datasheet is the first document to refer to for model-specific information related to RCC models
such as pin-outs and other key installation information. Visit the Horner websites to obtain datasheets,
user documentation, and updates.

4.1  Grounding Definition

Ground: The term ground is defined as a conductive connection between a circuit or piece of equipment
and the earth. Grounds are fundamentally used to protect an application from harmful interference
causing either physical damage such as by lightning or voltage transients or from circuit disruption often
caused by radio frequency interference (RFI). Grounding is also for the safety of the user.

4.2  Ground Specifications

Ideally, a ground resistance measurement from equipment to earth ground is 0 ohms. In reality it typically
is higher. The U.S. National Electrical Code (NEC) states the resistance to ground shall not exceed
twenty-five (25) ohms. Horner APG recommends less than fifteen (15) ohms resistance from our
equipment to ground. Resistance greater than twenty-five (25) ohms can cause undesirable or harmful
interference to the device.

4.3 How to Test for Good Ground

In order to test ground resistance, a Ground Resistance Tester must be used. A typical Ground
Resistance Meter Kit contains a meter, two or three wire leads, and two ground rods. Instructions are
supplied for either a two-point or three-point ground test.

GROUND RESISTANCE METER

GROUND L DCE_I):
DISCONNECTED % 1

FROM SERVICE

S |
GROUND ROD

METAL WATER PIPE OR
OTHER GOOD GROUND

Figure 4.1 — Two-Point Ground Connection Test
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To power the RCC unit, V+ and V- wires are directly wired to the terminal strip.

Table 4.1 — Primary Power Port Pins

PIN Signal Description
V+ DC IN Input power supply positive voltage
C ov Input power supply ground
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CHAPTER 5: SERIAL COMMUNICATIONS

51 Overview

All RCC models provide serial ports. On the RCC2414 it is provided through the terminal, and on the
RCC1410 it is on the 8-pin modular RJ45 connector, which is labeled MJ1. The RCC2414 has two RS-
485 Half-Duplex serial connections, and the RCC1410 MJ1 serial port is RS-485 and RS-232. By default,
the serial ports can be connected to the COM port of a PC running Cscape, for controller programming. In

addition, serial ports can be used for application-specific communication, using a variety of standard data
exchange protocols.

5.2  Port Descriptions

The RCC2414 has terminal serial port connections which support two RS-485 Half-Duplex serial
connections. The MJ1 serial port contains an RS-485 and RS-232 interface with RTS/CTS handshaking.

53 MJ1 Serial Port Pinout

0000
Iy y . . oy e

XR+ XR- C XR+ XR- 1

Port 1 Port 2

Pin RCC2414 Serial port pins ‘

Pin RCC 1410 MJ1 Pins

8 TXD ouT 8 TXD ouT
9 RXD IN 7 RXD IN
10 oV Ground 6 oV Ground
+5V +5V
11 (60mA ouT 5 (60mA ouT
Max) Max)
12 RTS ouT 4 RTS ouT
3 CTS IN
2 RX/TX IN/OUT
1 RX/TX IN/OUT

Figure 5.1 — RCC Serial Port Detail

5.4  Cscape Programming via Serial Port

The RCC1410 MJ1 serial port supports CsCAN Programming Protocol. If a PC COM port is connected to
the RCC MJ1 serial port, Cscape can access the RCC for programming and monitoring. Programming
can also be done via the CAN connection or Ethernet.

55 Ladder-Controlled Serial Communication

Using Serial Communication function blocks, MJ1 supports Generic Modbus Master and Modbus Slave
Protocols. In addition, external modems can be connected and accessed using Init, Dial, and Answer
Modem function blocks.
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5.8 Downloadable Serial Communication Protocols

MJ1 supports downloadable protocols, such as Allen Bradley DF1, CsCAN Master, GE Fanuc SNP and
Modbus Master.

NOTE: Refer to the download section of the Horner websites for the list of latest supported protocols.
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CHAPTER 6: CAN COMMUNICATIONS
Note: For additional CAN information, refer to the CAN Networks manual (MANO0799) on the Horner
websites.
6.1 Overview

All RCC models provide CAN networking options, which are implemented with CL and CH connections at
the terminal. The CAN connection is terminated (120 ohm resistor) at the end of the network wiring for
proper functionality.

Figure 6.1 — CAN Connections Location

Like the serial ports, the CAN connection can be used for RCC programming by connecting it to a PC
running Cscape. The CAN port also allows the RCC to exchange global data with other OCS/RCS
controllers. CAN supports accessing of remote network 1/0O devices (SmartStix, SmartBlock and
SmartRail Modules.)

6.2  Port Description

The RCC CAN ports implement the ISO 11898-2 physical layer and the CAN 2.0A data link layer
standards. Also, since the CAN ports are powered by an internal isolated power supply, external CAN
power is not required.

6.3  CAN Port Wiring

Note: The CN L and CN H Communication wires mustb e terminated with a 120 ohm resistor.

RCC2414 CAN Port Assignments

CNH CAN Data High — High In/Out
CNL CAN Data Low — Blue In/Out
V- CAN Ground -

RCC1410 CAN Port Assignments

CNL CAN Data Low — Blue In/Out
CNH CAN Data High — High In/Out
V+ DC Power Out
V+ DC Power Out
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6.4  Cscape Programming via CAN

The CAN port supports CsCAN Programming Protocol. If a PC has a CAN interface installed (via PCI
card or USB), and the PC CAN port is connected to the RCC CAN port, Cscape can access the RCC for
programming and monitoring.

In addition, the RCC supports single-point-programming of all RCC and other OCS/RCS devices that are
connected to the CAN port network. If the PC COM port is connected to the RCC1410 MJ1 serial port,
the RCC can act as a pass-through gateway allowing Cscape to access all RCC and OCS/RCS devices
that are attached to the CAN port network.

6.5 Ladder-Controlled CAN Communication

Using Put and Get Network Words function blocks, the CAN port can exchange digital and analog global
data with other RCC or OCS/RCS devices (nodes) attached to the CAN port network.

In addition, Put and Get Network Heartbeat function blocks allow nodes on the CAN port network to
regularly announce their presence and to detect the presence (or absence) of other nodes on the
network.

6.6  Using CAN for I/O Expansion (Network 1/0)

Connecting Network I/O devices (SmartStix, SmartBlock or SmartRail) to the RCC CAN port, allows the
RCC 1/0O to be economically expanded and distributed. A variety of modules are available for this
purpose.
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CHAPTER 7: ETHERNET COMMUNICATION

7.1 Ethernet Module Protocols and Features

The following table describes the Ethernet Module Protocols and features supported by RCC.

Protocol / Feature Protocol / Feature Description \
ICMP Ping Internet Control Message Protocol
EGD (Peer) Ethernet Global Data
SRTP Server Service Request Transfer Protocol
CsCAN TCP Server Horner APG CsCAN over Ethernet
Modbus TCP Slave Modbus over Ethernet
Ethernet / IP Server ODVA CIP over Ethernet
FTP Server File Transfer Protocol
HTTP Server HyperText Transfer Protocol (Web Server)

Table 7.1 — Ethernet Module Protocols & Features

7.2  Ethernet System Requirements

Full Ethernet functionality requires:
- PC running Cscape Programming Software Version 9.3 SP6 or later (for configuration).
- RCC controller with onboard Ethernet port.
- FTP & HTTP protocaols.

7.3  Ethernet Module Specifications

10 BaseT Ethernet (10-Mbps)

100 BaseTx Fast Ethernet (100-Mbps)
Modes Half or Full Duplex

Auto -Negotiation Both 10/100-Mbps and Half/Full Duplex
Connector Type Shielded RJ-45

Cable Type

(Recommended) CATS5 (or better) UTP

Port Auto MDI/MDI-X (Auto Crossover)
Table 7.2 — Ethernet Module Specifications

Speeds

7.4  Ethernet Module Configuration
Note: The following configuration is required for all applications regardless of the protocols used.
Additional configuration procedures must be performed for each protocol used.

To configure the Ethernet Module, use Cscape Programming Software to perform the following steps

1. On the main Cscape screen, select the Controller menu and its I1/O Configure sub-menu to
open the 1/0 Configuration dialog (Figure 7.1)

2. If configuring a different Product Model than the one shown in the 1/O Configuration dialog,
click on the topmost Config button, select the desired PRODUCT Model, and then click OK
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Hardware Configuration S e

Cortroller | Local 1/0 | CANT (CsCAN) 11O | LANT 120 | LANZ 170 |

Description:
|Micm PLC with low cument ouputs

Device Type |HERCC

L]

— Properties
Maodel #: IHEF{[II—24‘I4 vi
Display Type:  [NONE
— Network Ports Keypad Type: INDNE
CAN1 [CsCAN ~] Corfig | Program Memory: |125 K Bytes
CANZ | +] Gontig | Network Type:  [CsCAN
LANT ] Advanced Ladder Functions
IEFNBM _I ﬂl Supports Analog Data
= Real Time Clock Support
s IETNEED —I ﬂl Supports Retertive Data
Senal Ports Config |

Auto Corfig

Figure 7.1 — 1/O Configuration Dialog

3. Click the Config button to the right of LAN1 revealing the Ethernet Module Configuration dialog

as shown in figure 7.2
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r IR
LAN1 Configuraticn L&J
Register lzage

Diefault Settings Fiegister

Get zefttings fram

IPAddress: [ ER . 168 . 254 . 128

M arne: |

Li 3ZEIT ]Eonfiguration ﬂ [T Use CAM ID for last Octet

Nethask: | 256 285 265 . 0

I arme: ]

| #E [Corfiguation ~ |

Gateway | 0 . 0. 0.0

E |

Ll 32T 1[onflguration _J

Status:

Mame: ]

Li 15-EIT ]

ersion:

Pratacaol Suppart -
Resident Protocals

[CJICMP (Ping)
[1EGD (Ethernet Global Data)
] SRTP Slave (90-30 Service Request)
[ Modbus Slave
[ Ethernet/IP
] FTP (Fite 5erver)
[CIHTTP (Web Server)
1 ASCI Over TCP/IP

- Downloadable Protocols -

I .arne: |

ETH1A |- Hare -

ETN1/2 |- None -

Led Led

vj 16-EIT |

Configure Selected Protocal

aK I Cancel

Figure 7.2 — Ethernet Module Configuration

4.  Configure the Ethernet Module parameters as follows:

IP Address: Enter the static IP Address for the Ethernet Module being configured.

Note: IP Addresses are entered as four numbers, each ranging from 0 to 255. These four
numbers are called octets and they are always separated by decimal points.

Net Mask: Enter the Net Mask (sometimes called Subnet Mask) being used by all nodes on the local
network. Typical local networks use Class C IP Addresses, in which case the low octet (rightmost
number) is used to uniquely identify each node on the local network. In this case, the default Net Mask

value of 255.255.255.0 should be used.

Gateway: Enter the IP Address of a Gateway Server on the local network that allows for communication
outside of the local network. To prevent the Ethernet Module from communicating outside the local
network, set the Default Gateway IP Address to 0.0.0.0 (the default setting).

Status Register: Enter an Register reference (such as %R100) to indicate which 16-bit register will have
the Ethernet Status word written to it. Table 7.3 shows how this register value is formatted and explains

the meaning of each bit in the Status Word.
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Table 7.3 - Ethernet Status Word Register Format

High Byte Low Byte
Bit | Bit | Bit | Bit | Bit | Bit | Bit | Bit | Bit | Bit Bit | Bit | Bit Bit | Bit | Bit
16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1
0 0 Dup | Spd 0 Rx Tx | Link TCP Connections
Status Bit(s) Status Indication — SIS YAIES -
Minimum [ Maximum
0 Reserved Always 0
Dup Link Duplex (Auto-Negotiated) 0 = Half Duplex | 1 = Full Duplex
Spd Link Speed (Auto-Negotiated) 0 =10 MHz 1 =100 MHz
Rx Receive State 0 = Inactive 1 = Active
TX Transmit State 0 = Inactive 1 = Active
Link Link State 0 = Down 1=Up
. Total Number of Active TCP Connections
TCP Connections | scAN, SRTP, Modbus, EIP, FTP, HTTP) 0 40

Version Register: Enter a Register reference (such as %R101) to indicate which 16-bit register will have
the Ethernet Firmware Version written to it. The value stored in the Version Register is: (Ethernet
Firmware Version * 100). For example, for Ethernet Firmware Version 4.30, the Version register will
contain 430.

Get Settings From:

“Get settings from” allows the programmer to either configure the IP Address, Net Mask, or Gateway for 2
functions: Configuration or Register

Configuration — The configuration for the IP Address, Net Mask, or the Gateway will be assigned using
the value in the Default Settings in this window.

Register — The configuration for the IP Address, Net Mask, or the Gateway will be assigned using the
values in the registers assigned.

Ethernet Module Protocol Configuration

The Protocol Support area contains a list of all the protocols supported by the platform being configured.
To activate a protocol, check its checkbox.

For protocols that require additional configuration, click on a listed protocol to select it and then click the
Configure Selected Protocol button. This will open a new dialog with configuration options for the selected
protocol.

For detailed information on individual protocol configuration refer latest version of ETN 300 Manual
SUPQ740
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CHAPTER 8: REMOVABLE MEDIA

8.1 Overview

All RCC models provide a Removable Media slot, labeled Memory Card , which supports standard
MicroSD Flash memory cards. MicroSD cards can be used to save and load applications, to capture
graphics screens and to log data for later retrieval.

Figure 8.1 — Removable MicroSD Memory Card Slot

8.2 MicroSD Cards

Cards labeled either MicroSD or TransFlash, with up to 32 GB of Flash memory, are compatible with the
RCC Memory slot.

The Memory slot is equipped with a “push-in, push-out” connector and a MicroSD card can be safely
inserted into the Memory slot whether the RCC power is On or Off.

To install a MicroSD card : Align its 8-pin gold edge connector down, facing the front of the RCC unit as
shown in Figure 9.2 ; then carefully push it all the way into the Memory slot. Ensure that it clicks into
place.

To remove the MicroSD card : Push in on the top of the card gently to release the spring. The card
pops out for removal.

8.3  MicroSD File System

The MicroSD Memory slot uses the PC-compatible FAT32 File System. This means that a PC, with a
MicroSD-compatible card reader, can read files that have been written by the RCC and can write files that
can be read by the RCC.

However, the RCC does not support long filenames, but instead implements the 8.3 filename format. This
means that all file and directory names must consist of up to 8 characters, followed by an optional dot,
and an optional extension with up to 3 characters.

Directories and sub-directories can be nested up to 16 levels deep as long as each pathname string does
not exceed 147 characters.
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8.5 Using Removable Media to Log Data

Using Read and Write Removable Media function blocks, an application ladder program can read and
write RCC register data in the form of comma-delimited files, with a .CSV extension. These files are
compatible with standard database and spreadsheet PC programs. In addition, an application ladder
program can use Rename and Delete Removable Media function blocks to rename and delete files.
8.6  Using Removable Media to Load and Save Applicat ions

A special file type, with a .PGM extension, is used to store RCC application programs on MicroSD.

Pressing and holding the LOAD button for three seconds upon power up will load the program that is
stored on the MicroSD. (more details in Chapter 11)

Cscape can also save an application directly to a MicroSD card, which is plugged into the PC’s MicroSD
compatible card reader by selecting the Export to Removable Media item on the Cscape File menu.

8.8 Removable Media (RM) Function Blocks in Cscape

NOTE: For detailed information regarding RM functio  n blocks and parameters, refer to the help file
in Cscape Software.

The following RM functional blocks are available in Cscape Software. These function blocks will reference
- MicroSD when filename is prefixed with ‘A:’ or nothing

Read RM csv Allows reading of a comma-separated value file from the MicroSD interface into
the controller register space.

Write RM csv Allows writing of a comma-separated value file to the MicroSD interface from the
controller register space.

Rename RM csv Allows renaming a file on the RM card. The data in the file is not changed.

Delete RM csv Allows deleting a file on the RM card

Copy RM csv Allows copying a file on the RM card. The data in the file is not changed.

8.9  Filenames used with the Removable Media (RM) Fu nction Blocks

The RM function blocks support the flash with a DOS/Windows standard FAT-16 file system. All names
must be limited to the “8.3" format where the filename contains eight characters a period then a three-
character extension. The entire filename including any path must be less than or equal to 147 characters.

When creating filenames and directories it is sometimes desirable to include parts of the current date or
time. There are six special symbols that can be entered into a filename that are replaced by the RCC with
current time and date information.

Table 9.1 — Filename Special Symbols \

Symbol Description Example
$Y Substitutes the current 2 digit year 2015=15
$M Substitutes the current month with a 2 digit code March = 03
$D Substitutes the current day 22nd = 22
$h Substitutes the current hour in 24 hour format 4pm=16
$m Substitutes the current minute 45 = 45
$s Substitutes the current second 34 =34

Note that all the symbols start with the dollar sign ($) character. Date symbols are in upper case, time
symbols are in lower case. The following are examples of the substituted time/date filenames:
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Current date and time = March 1, 2015 3:45:34 PM
Filename: Data$M$D.csv = Data0301.csv
Filename: Year$Y\Month$M\aa$D_$h.csv = Year15\MonthO3\aa0l1_15.csv
Filename: Month_$M\Day $D\$h_$m_$s.csv = Month_03\Day_01\15_45 34.csv

Note: Time/Date requires setting on the RCC1410 and RCC2414, and is only maintained while the
RCC is powered. Time and Date will need to be reco nfigured on power cycle.

8.10 System Registers used with RM

%SR175 Status This shows the current status of the RM interface

%SR176 Free Space This 32-bit register shows the free space on the RM card in bytes

%SR178 Card Capacity | This 32-bit register shows the total card capacity in kilobytes

Possible status values are shown in the table:

Table 9.2 — RM Status Values

RM interface OK
Card present but unknown format
No card in slot
Card present, but not supported
Card swapped before operation was complete
Unknown error

QR |WIN[F|O

For additional status information, consult the Cscape help file.
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CHAPTER 9: GENERAL 1/O

Note: Each RCC unit is sent with a datasheet in the box. The datasheet is the first document to refer to
for model-specific information related to RCC model s such as pin-outs and other key installation
information . Visit the Horner websites to obtain datasheets, user documentation, and updates.

9.1 Overview

The RCC is a compact unit that contains high density, very versatile /0. Using the 1/O properly requires
wiring to the proper terminals unit and configuring Cscape properly. This section will offer some tips and
suggestions to configure the 1/O properly. For the register mapping of the 1/O, refer to the Index at the
end of this manual for the pages referencing register mapping.

9.2  Solid-State Digital Outputs

Solid-state digital outputs are generally used to activate lamps, low voltage solenoids, relays and other
low voltage and low current devices.

NOTE: The digital outputs used on the RCC are “sourcing” outputs. This means the output applies a
positive voltage to the output pin when turned ON. When turned off, the output applies approximately zero
volts with respect to the 1/0 ground.

The digital outputs used in the RCC have electronic short circuit protection and current limiting. While these
electronic protections work in most applications, some application may require external fusing on these
outputs.

The digital outputs in the RCC are typically controlled via %Q bits in the register mapping.
When the controller is stopped the operation of each output is configurable. The outputs can hold the state
they were in before the controller stopped or they can go to a predetermined state. By default digital outputs

turn off. For more information on stop state see the Index to find pages referencing Cscape settings.

The digital outputs feature an output fault bit. %132 will turn on if any of the outputs experience a short
circuit, over-current or the output driver overheats.

9.3 Digital Inputs

Note: The digital inputs on the RCC are designed for low voltage DC inputs. The inputs are designed to
support both positive and negative input modes. The mode is set by a configuration parameter in
Cscape. All the inputs on the unit must be configured to the same mode.

Positive Logic vs. Negative Logic Wiring
The RCC SERIES CONTROLLER can be wired for Positive Logic
inputs or Negative Logic inputs.

001XLEO36

+
12-24vDC O

Positive Logic In Negative Logic In

Figure 10.6 — Positive and Negative Inputs
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In positive logic mode a positive voltage applied to the input will turn the input. The internal design of this
mode is basically a resistor from the input to /0O ground. This mode is sometimes called sourcing.

In negative logic mode, connecting the input to the 1/0 ground or zero volts will turn the input on. The
internal design of this mode is basically a resistor from the input to the positive I/O voltage (usually 12 or
24 volts). This mode is sometime called sinking.

9.4  Analog Inputs on the RCC2414

NOTE: See the data sheet for the RCC model being used and see the appropriate page in this manual
(see Index) for details on how to use Cscape to configure the digital filtering.

The analog inputs on the RCC2414 allow voltage or current measurement from a variety of devices.
Analog inputs read 0-10 VDC only.
The analog inputs have a digital filter that can be used to filter electrical noise that may be unavoidable in

some installations. The downside to digital filtering is the inputs will respond more slowly to sudden
changes in the actual input.

9.5 Analog Outputs on the RCC2414

Note: Refer to the datasheet for RCC model being used for details on jumper settings.

The analog outputs on RCC2414 devices provide 0-10 V output.

When the controller is stopped the operation of each output is configurable. The outputs can hold the
state they were in before the controller stopped or they can go to a predetermined value. By default

analog outputs are set to a value of zero. For more information on Stop State, refer to the appropriate
pages (see Index) for the configuration chapter for Cscape settings.
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CHAPTER 10: CSCAPE CONFIGURATION

10.1 Overview

RCC hardware is programmed with a Windows based PC application called Cscape. This application can
be used to program, configure, monitor and debug all aspects of the RCC unit. Please see the on-line
help provided with Cscape for additional details.

10.2 Cscape Status Bar

When the RCC is connected to a PC using Cscape software a Status Bar appears at the bottom of the
screen. The Cscape Status Bar can be used to determine if communications have been established
between the RCC and the Cscape program. Components of the Cscape Status Bar are explained below.

Message Line - Equal Indicator - indicates whether the current program in Cscape is equal to the program

The contents of stored in the Target Controller.

these messages ¢ If Equal, the program in Cscape is the same as the program stored in the Target Controller.

are context « If Not Equal, the program in Cscape is not the same as the program stored in the Target

sensitive. The Controller.

Message line can » If Unknown , there may have been a change since the last time the program in Cscape was

be empty. compared to the Target Controller.
Current User - File Modified Indicator - indicates that
indicates who is logged the file in the selected window has
(for security purposes). been modified but has not been saved.

Ready User: HE-XExx1-CsCAN Equal | Local :1 Target :2(R) [no MOD

(Model=) forces]
Controller Model - Network (Model Confirmation) Communications Status - indicates the current status of the

“pass through” Connector.
. Controller Model indicates the controller model for

which the program in Cscape is configured. «  Local: xx — indicates the Network ID of the CONTROLLER
to which the Cscape program is physically connected
*  Network indicates the type of network that the program through its serial port. It can serve as a pass through
in Cscape expects to use (e.g., CSCAN). device to other nodes on the network.
*  (Model Confirmation) provides the following «  Target: yy(R) —indicates the Network ID of the device with
indications: which the Cscape program is exchanging data.
Note: The Local unit and Target unit can be the
. (Model=) - the actual Target Controller matches the same unit or they can be separate units.

configured Controller Model and Network.
The following are status indicators:
. (Model Not=) — the actual Target Controller does not

match the configured Controller Model and Network. (R) — Running
(D) - Do l/o
. (Model ?) —there may have been a change since the (1) —Idle
last time the Target Controller was compared to the (?) — Cscape is not communicating with the remote unit.
configured Controller Model and Network. [no forces] — indicates no I/O has been forced.

Figure 10.1 - Cscape Status Bar
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10.3 Establishing Communications

The preferred method of communicating between Cscape and an RCC is via serial port. The RCC can
communicate with Cscape using serial port communications, Ethernet, and CAN (CsCAN). For
communications other than MJ1 port please refer to the manual which ships with the communications
adapter hardware being used for programming.

For RCC use Cscape Ver 9.30 SP6 or later.
On the RCC1410, connect a PC (Personal Computer running a Windows Microsoft operating system)

serial port to the MJ1 port. CBL600 adapter and cable can be used to connect the MJ1 port to the PC’s
USB port

Figure 10.2 — MJ1 Connector on the RCC1410 to be used via Serial or with Serial to USB adapter to PC

If the recommended CBL600 serial to usb adapter is used, the PC should automatically
recognize it.

Now that the RCC is plugged in, go to Cscape, Tools, Application Settings, Communications,
Configure>> and choose the USB port (in this example Com 3).
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[ |
Add Target [

Target Name; |Defau\t1

- Connection Medium

" Com Por: 1 :JJ

(" Ethernet [ 172 .27 1 .6 Fart ]13501 Mode: |Bulbin/ETH Ethemist Mode |

1500
7 CanInterface:
[camisoo =]
7 Installed Modem |Agere:’:y‘stem3 HD& Maodem J

[USE Serial For (COM4) =]

Connected Device

% Connected Device " TargetMode 1D |1 j

Connection Settings

Maximum Baud Rate: | 57600 -
Timeout {20000 ms

0k Cancel

If communication is established, the target indicator will show the mode of the controller
Target: yy(R) as shown in the status section above in this chapter, section Cscape Status Bar.

If the controller is not communicating, ensure the target ID is set correctly. The Target ID allows directing
communications to a particular unit when multiple units are connected via a CsCAN network. Units
without CsCAN network ports respond to any network ID and do not require the ID to be configured.

To change the RCC target ID in Cscape, go to Controller ->Set Local Network ID .

10.3.1 Communicating via MJ1 Serial Port on the RCC 1410

Start by configuring Cscape to use the correct communications port. This can be done using the
Tools ©2Options > Communication Port dialog in Cscape.

Connect the PC'’s serial port to the port labeled MJ1 on the RCC.

If communications are successful, the target indicator should show the mode of the controller Target:
yy(R) as shown in the status section above.

If the controller is not communicating, it may be required to set the target ID of the controller in Cscape
The Target ID allows directing communications to a particular unit when multiple units are connected via
a CsCAN network. Units without CSCAN network ports respond to any network ID and do not require the
ID to be configured.

To change the Target ID of Cscape use the Controller - Set Target Network ID dialog.

10.3.2 Communicating via On Board Ethernet Port

From Cscape go to Controller -> I/O Configure and do auto configuration for the connected controller,
Click on Config of Ethernet & go to Module Setup.
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The IP address, Net Mask and Gateway of the controller may be temporarily set from the system menu
under the Set Networks menu item. Once running or power cycled the configuration will come from the
Cscape configuration stored in the unit.

In Module configuration dialog go to IP Address field enter unused IP Address and configure unused
registers in Register field & then click OK. Screen shot for the same as follows:

r IR
LAN1 Configuraticn L&J

Reaqister Uzage

Diefault S ettings Fregister Get gettings from
IPAddress: [ [EH . 168 . 254 . 128 | Maame: | | e |Configuiation = | [ Use CAN ID for last Ootet
MNetMask: | 265 256 255, 0 | Name: | x| B [Configuration ~ |
G ateway: ] 0.0.0.a0 ] Name;l LJ BT 1Eonflgurdtion _J
Status: | Name: | | s |
Wersion: | Name:l :_1 T6BIT ]

Frotocol S upport -
Resident Protocols

[JICMP (Ping)

[[1 EGD (Ethernet Global Data) Configure Selected Protocol
[C]SRTP Slave (90-30 Service Request)
[ Modbus Slave

D Ethernet/IP

] FTP (File Server)

CJHTTP (Web Server)

] ASCI Over TCR/IP

i~ Downloadable Protocols -

ETN1/1 [ None - =] | Newwork || Devises | | GeanLit |

ETN1/2 [~ None - -] ‘ | |

oK I Cancel ‘

Download the configuration in to Controller. Connect LAN cable to the Controller in default LAN Port.

From Cscape go to Tools ->Editor Options - Communication Port > Configure . Select Ethernet and
enter IP address which is configured in the file.

The controller should get connected to Cscape. If communications are successful, the target indicator
should show the mode of the controller Target: yy(R) as shown in the status section above.
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I/0O Configuration

An overview of configuration:
Start the configuration by selecting the Controller | I/O Configure menu item.

If the RCC is connected to the PC press the Auto Config System button to automatically detect

the Base model, I/0 and any communication options.
If the RCC is not connected press the Config button to the right of the top of the unit. This allows

1.
2.

3.

the base CPU to be selected.

Select RCC Series from the type drop down box.
Click Local /0 Tab and then Configure to bring up the Module Configuration menu. From here

the 1/O registers can be viewed.

-
Module Configuration

RCC1410 Configuration

i~ Module
Model: HE-RCC1410
Description: RCC Integrated /0

Ending  Mumber of
Register Registers

2

Type  Starting
Register

A
w1
%Al [NONE
%A0 INONE

Cancel

===

RCC User Manual

-
Meadule Configuration

=)

RCC2414 Corfiguration

Module
Model: HE-RCC2414
Description: RCC Integrated 1/0

Type Stating Ending
Register Register

< il I (N
w Al [re
[ [T
wo [ 4

Number of
Registers

[z
B
=
B

Cancel

Next, click RCC1410 or RCC2414 Configuration to configure:

Digital inputs active mode

Positive or negative

Digital output state on controller stop

High, low, or stop.

Output value on STOP

Contains items that allow the user to specify how the
outputs behave when the controller is stopped. These
items can either hold their value or default to some value

when the controller is stopped.

Analog input settings (if applicable)

Adjust filter constant for system noise.
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Madule Configuration % . ﬁ Maodule Configuration = - ﬂ
1#0 Map 1/0 Map
— Digital inputs active mode = — Digttal inputs active mode
(* Positive Logic | * Postive Logic |
" Negative Logic " Negative Lagic
r— Digital Output State on Controller Stop — = — Digttal Output State on Controller Stop -
1 2 3 4 5 1 2 3 4
32|34 43|33

3)3/3)a) 3]
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When programming the RCC, data is stored in memory that is segmented into different types. This
memory in the controller is referred to as registers. Different groups of registers are defined as either bits
or words (16 bits). Multiple registers can usually be used to handle larger storage requirements. For
example 16 single bit registers can be used to store a Word or two 16 bit registers can be used to store a

32-bit value.

Below is a table of the type of registers found in the OCS.

Register Description

%Al Analog Input

16-bit input registers used to gather analog input data such as voltages, temperatures,
and speed settings coming from an attached device.

%AQ Analog Output

16-bit output registers used to send analog information such a voltages, levels or speed
settings to an attached device.

%AIG Global Analog Input

Specially defined 16-bit input registers that come from the network.

%AQG Global Analog Output

Specially defined 16-bit output registers that go to the network.

%D Display Bit

These are digital flags used to control the displaying of screens on a unit which has the
ability to display a screen. If the bit is SET, the screen is displayed.

%I Digital Input

Single-bit input registers. Typically, an external switch is connected to the registers.

%IG Global Digital Input

Specially defined single-bit inputs that come from the network.

%K Key Bit

Single-bit flags used to give the programmer direct access to any front panel keys
appearing on a unit.

%M Retentive Bit

Retentive single-bit registers.

%0Q Digital Output

Single-bit output registers. Typically, these bits are connected to an actuator, indicator
light or other physical outputs.

%QG Global Digital Output

Specially defined single-bit outputs that go to the network.

%R General Purpose Register

Retentive 16-bit registers.

%S System Bit

Single-bit coils predefined for system use.

%SR System Register

16-bit registers predefined for system use.

%T Temporary Bit Non-retentive single-bit registers.
11.2 Useful %S and %SR registers
Table 14.1 — Common %S Register Definitions
Register Description
%S1 Indicate First Scan
%S2 Network is OK
9%S3 10mS timebase
%S4 100mS timebase
%S5 1 second timebase
%S6 I/0 is OK
%S7 Always ON
%S8 Always OFF
%S9 Pause 'n Load soon
%S10 Pause 'n Load done
%S11 I/O being forced
%S12 Forcing is enabled
%S13 Network /O is OK
%S16 Ethernet COM module is OK
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Table 11.2 — %SR Registers

Register Name Description Min Val Max Val
%SR1 USER_SCR Current User Screen Number 1 1023
%SR2 ALRM SCR Current Alarm Screen Number (O=none) 0 1023
%SR3 SYS SCR Current System Screen Number (0=none) 0 14
%SR4 SELF TEST Bit-Mapped Self-Test Result 0 65535
%SR5 CS_MODE Control Station Mode (0=Idle, 1=Do I/O, 2=Run) 0 2
%SR6 SCAN RATE Average Scan Rate (/10) - 1000
%SR7 MIN RATE Minimum Scan Rate (/ 10) - 1000
%SR8 MAX RATE Maximum Scan Rate (/ 10) - 1000
%SR9-10 EDIT_BUF Data Field Edit Buffer 0 2%2-1
%SR11-12 LADDER_SIZE | Ladder Code Size 2 256K
%SR 13-16 Reserved - - -
%SR17-18 10_SIZE I/O Configuration Table Size 16 127K
%SR19-20 NET SIZE Network Configuration Table Size 34 1K
%SR21-22 SD_SIZE Security Data Table Size - -
%SR23 LADDER CRC | Ladder Code CRC 0 65535
%SR 24-25 Reserved - - -
%SR26 10 CRC I/O Configuration Table CRC 0 65535
%SR27 NET CRC Network Configuration Table CRC 0 65535
%SR28 SD CRC Security Data Table CRC 0 65535
%SR29 NET_ID This Station’s Primary Network ID (CsCAN) 1 253

Network Baud Rate (CsCAN
6SR30 NET_BAUD (0=125KB; 1:250KB(; 2:500I)<B; 3=1MB) 0 3
Network Mode (O=network not required; 1=network
%SR31 NET_MODE required; 2=network optimized; 0 3
3=network required and optimized)
%SR32 LCD CONT LCD Display Contrast setting 0 255
%SR33 FKEY MODE Function Key Mode (0O=Momentary; 1=Toggle) 0 1
RS232 Serial Protocol Mode
O=Firmware Update (RISM); 1=CsCAN; 2=Generic
%SR34 SERIAL_PROT ELadder- Contrglled); g=M03bus RTU; 4=Modbus 0 4
ASCII)
%SR35-36 SERIAL_NUM | This Station’s 32-bit Serial Number 0 2%2-1
%SR37 MODEL _NUM This Station’s Binary Model Number 0 65535
%SR38 ENG REV Firmware Rev Number (/100) 0000 9999
%SR39 CPLD_REV BIOS Rev Number (/100) 000 255
%SR40 FPGA REV FPGA Image Rev Number (/ 10) 000 255
%SR41 LCD COLS Vertical Pixel Count
%SR42 LCD ROWS Horizontal Pixel Count
%SR43 KEY TYPE Keypad Type
%SR44 RTC SEC Real-Time-Clock Second 0 59
%SR45 RTC MIN Real-Time-Clock Minute 0 59
%SR46 RTC HOUR Real-Time-Clock Hour 0 23
%SR47 RTC DATE Real-Time-Clock Date 1 31
%SR48 RTC MON Real-Time-Clock Month 1 12
%SR49 RTC YEAR Real-Time-Clock Year 1996 2095
%SR50 RTC DAY Real-Time-Clock Day (1=Sunday) 1 7
%SR51 NET CNT Network Error Count 0 65535
%SR52 WDOG CNT Watchdog-Tripped Error Count 0 65535
%SR53-54 BAD LADDER | Bad Ladder Code Error Index 0 65534
%SR55 F SELF TEST | Filtered Bit-Mapped Self-Test Result 0 65535
%SR56 LAST KEY Key Code of Last Key Press or Release 0 255
LCD Backlight Dimmer Register
%SR57 BAK_LITE 0=0% On;g25=25% On; 1%0-255 =100% On 0 255
%SR58 USER LEDS User LED Control / Status 0 65535
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Table 11.2 — %SR Registers

Register Name Description Min Val Max Val
%SR59-60 Reserved - - -
%SR61 NUM IDS This Station’s Number of Network IDs 1 253
%SR62 NUM_IDS This Station’s Number of Network IDs 1 253
%SR63 SS BASE SmartStack 1/0 Base Selector 0 7
%SR64 SS STATUS SmartStack 1/0 Base Status 0 2
%SR65-76 SS_INFO_1 SmartStack I/0O Module #1 Information Structure - -
%SR77-88 SS INFO 2 SmartStack 1/0 Module #2 Information Structure - -
%SR89-100 SS_INFO_3 SmartStack I/0O Module #3 Information Structure - -

%SR101-112 SS_INFO_4 SmartStack I/0O Module #4 Information Structure - -

%SR113-114 GOBJ_SIZE Graphics Object Table Size 8 256K

%SR115-116 GSTR_SIZE Graphics String Table Size 8 128K

%SR117-118 GBMP_SIZE Graphics Bitmap Table Size 4 256K

%SR119-120 GTXT_SIZE Graphics Text Table Size 8 128K

%SR121-122 GFENT_SIZE Graphics Font Table Size 8 256K

%SR123-124 PROT SIZE Protocol Table Size 16 64K
%SR125 GOBJ CRC Graphics Object Table CRC 0 65535
%SR126 GSTR CRC Graphics String Table CRC 0 65535
%SR127 GBMP CRC Graphics Bitmap Table CRC 0 65535
%SR128 GTXT _CRC Graphics Text Table CRC 0 65535
%SR129 GFNT_CRC Graphics Font Table CRC 0 65535
%SR130 PROT CRC Protocol Table CRC 0 65535
%SR131- Reserved - - -

163
Read bit indicating Auto Restore of Register Data

%SR164.3 has been perform%d (Fail Safe) ’

%SR164.4 Read bit indicating Backup of Register Data has

been performed (Fail Safe)

%SR164.5 Enable AUTORUN (Fail Safe)

%SR164.6 Enable AUTOLOAD (Fail Safe)

%SR164.7 Backup trigger bit

%SR164.8 Clear Backup trigger bit

%SR164.9 MAKE_CLONE trigger bit

%SR164.10 LOAD_CLONE trigger bit

Status indicating Make Clone Fail (This bit goes

%SR164.11 high when Makg / Create clone fail(s) ’

%SR164.12 ﬁ.tatus indicating Load C!one Fail (This bit goes

igh when Load clone fails)

%SR165-174 Reserved
%SR175 slzrgigvable Current Removable Media interface status 0 6

%SR176-177 Rem.ovable !ndicates free space on the Removable Media card 0 231

Media in bytes.

%SR178-179 slzrgizvable Indicates the total card capacity in bytes. 0 28t
%SR180 Reserved - - -
%SR181 ALM_UNACK ;Jrré?](;k;)owledged Alarm (high bit indicates what
%SR182 ALM_ACT Active Alarm (high bit indicates what group #)

%SR183 SYS_BEEP System Beep Enable (O=disabled; 1=enabled)
%SR184 USER_BEEP Software configurable (0=OFF; 1=ON)

%SR185 SCR_SAVER Screen Saver Enabled (O=disabled; 1=enabled)
%SR186 SCR_SA_ TM Screen Saver Time in minutes (delay)

%SR187 NET_USE Average Net Usage of all units on the CAN network
%SR188 NET_MIN nM;?Vlvn(;lrlen Net Usage of all units on the CAN
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Register Name Description Min Val Max Val
%SR189 NET_MAX g/leatx(r;}tm Net Usage of all units on the CAN
%SR190 NT TX AVG Average Net Usage of this unit
%SR191 NT_TX MIN Minimum Net Usage of this unit
%SR192 NT TX MAX Maximum Net Usage of this unit

For additional information on system bits and registers, refer to the on-line help found in Cscape.

11.3 Register Map for RCC I/O

RCC 2414 Registers

%I1 to %12

Description

Digital Inputs

%I3 to %I15

Reserved

RCC 1410 Registers

Description

%Q1 to %Q4

Digital outputs

%A1 to %AI8

Analog inputs

%AQ1 to %AQ4

%I1 to %l 14 Digital Inputs
%I115 Reserved
%I116 %Q Fault Status
%Q1 to %Q8 Digital outputs

Analog outputs

11.4 Resou

rce Limits

Table 11.4 — Resource Limits

Resource Value

%S 13

%SR 192, 200-205

%T 2048

%M 2048

%R 4096

%K 5

%D 1023

%I 2048

%Q 2048

Y%Al 512

%AQ 512

%IG 64 (per ID)

%QG 64 (per ID)

%AIG 32 (per ID)

%AQG 32 (per ID)

Ethernet CsCAN, Ping, EGD, SRTP, Modbus TCP Master (Downloadable protocol) & Slave, Ethernet
IP, FTP, or HTTP @ 10 MBd or 100 MBd
125 kBd, 250 kBd, 500 kBd, or

CsCAN 1 MBd

Serial Ports RCC 1410: 1 RS-232 / RS-485 Ports. Software Selectable. RCC 2414: 2 RS-485 Half-Duplex

Il\li);mFl’oerrszCAN 64 w/o repeat (253 w/ 3 repeaters)

Ladder Code 128 KB
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CHAPTER 12: MAINTENANCE

12.1 Firmware Updates

The RCC products contain field updatable firmware to allow new features to be added to the product at a
later time. Firmware updates should only be performed when a new feature or correction is required.

Warning: Firmware updates should only be performed when the equipment being controlled by
the RCC is in a safe, non-operational state. Communication or hardware failures during the
firmware update process can cause the controller to behave erratically resulting in injury or
equipment damage. Make sure the functions of the equipment work properly after a firmware
update before returning the device to an operational mode.

Load switch
1. Pressing the LOAD switch during power-up boots from the Micro SD card. This starts a
Firmware Load if the Micro SD is bootable and valid firmware files are found on it.

2. After boot-up, pressing the LOAD switch for 3 seconds either starts a Firmware Load or an
Application Load depending upon what files are found on the Micro SD. If firmware files are
found, a Firmware Load is performed. If firmware files are not found and the DEFAULT.PGM file
is found, an Application Load is performed.

CHAPTER 13: TROUBLESHOOTING / TECHNICAL SUPPORT

Chapter 13 provides commonly requested troubleshooting information and checklists
topics.

for the following

- Connecting to the RCC controller
- Local controller and local I/O

- CsCAN Network

- Removable media

In the event that this information is not enough, please contact Technical Support at the locations
indicated at the end of this chapter.

LED - NORMAL FUNCTIONALITY

LED Load Program/Firmware Functionality

Flashing Flashing Flashing Stops
LED Off ON Flash (1Hz) Alternately Together
PWR No power 10-30Vdc Load program Download in Download fails, Download Complete,
applied applied or firmwre Progress number of flashes unit reboots (allow 30
OK Self test fail Self test pass 1/0 forcing indicates the error. seconds).
enabled.
RUN Stop mode Run Mode Do I/O Mode.

Switch - Normal Functionality

Load switch
- Used for firmware updated, as noted in previous section
Run/Stop switch
1. After boot-up, pressing the RUN/STOP switch for 3 seconds toggles the RCC between RUN and STOP
modes.

Switch — Erase Program Function
LOAD and RUN/STOP
1. After boot-up, pressing both Load and RUN/Stop switches for 3 seconds performs an “Erase All” function,
which deletes all application programs.
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LED — Diagnostic Functionality

The leds are also used to indicate some fault conditions in the unit. The two leds OK and RUN will flash a number of
times depending upon the fault. There will be a two second gap and the pattern will be repeated. The number of
flashes and the associated error are as follows:

No. of flashes Fault Meaning

2 The MAC ID is empty.

3 The internal MAC file is corrupt.

4 The MAC ID TXT file is invalid.

5 The MAC ID file is not found or the uSD card is empty or missing system files.

Diagnostic Led flashing table.

13.1 Connecting to the RCC

Cscape connects to the local controller automatically when the serial connection is made. The status bar
below shows an example of a successful connection. This status bar is located in the bottom right hand
corner of the Cscape window.

'|L|:u:al:253 Target:253(R) [no Forces]

In general the Target number should match the Local number. The exception to this is when the
controller is being used as a "pass through" unit where other controllers on a CsCAN network could be
accessed through the local controller.

Determine connection status by examining feedback next to Local & Target in the status bar of Cscape.

Local: ### If a number shows next to Local then communication is established to the local controller.

Cscape is unable to access the COM port of the PC. This could mean that Cscape is configured for a COM
Local: No Port port that is not present or that another program has control of the COM port. Only one Cscape window can
access a port at a time. Subsequent instances of Cscape opened will indicate No Port.

Cscape has accessed a PC COM port, but is not communicating with the controller. This typically occurs

Lol [ S when the controller is not physically connected.

Unknown communication error. Close Cscape, power cycle the controller and reopen Cscape with a blank

297
Local: 2?7 project. Check Local.

If | (idle), R (run), or D (do 1/O) shows next to Target number then communication is established to the

LB ElIRIE) target controller.

Communication is not established to the target controller. Check node ID of controller and set Target to
match. Make sure local connection is established.

Target: #(?)

Table 12.1 — Cscape Target & Local Numbers

13.1.1 Connecting Troubleshooting Checklist (serial port — MJ1 Programming)

1. Programming and debugging must use MJ1.

2. Controller must be powered up.

3. Ensure that the correct COM port is selected in Cscape. Tools > Editor
Options »Communications Port

4. Ensure that a straight through (non-null modem) serial cable is being used between PC and
controller port MJ1. (proper adapter programming cable alleviates this)
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5. Check that a Loaded Protocol or ladder is not actively using MJ1. Using the STOP recessed
button on the controller will make MJ1 available to Cscape.

6. Make sure the COM port of the PC is functioning. An RS232 serial loopback and Microsoft
HyperTerminal can determine positively if the COM port is working. Or connect to an alternate
device to determine if the port is working.

7. Successful communications with USB-to-serial adapters vary. If in doubt, Horner APG offers a
USB to serial adapter. Part number HE500USB600.

13.1.2 Connecting Troubleshooting Checklist (ETN po  rt programming)

1. Programming and debugging must use MJ1 or Ethernet Port.

2. Controller must be powered up.

3. Ensure that correct IP address is given in the Ethernet field and correct Mode is selected, in
Cscape: Tools = Editor Options > Communications Port

4. Ensure that the Ethernet Cable is connected between the controller and the Ethernet Hub.

5. Make sure the Ethernet cable is functioning properly.

13.2 Local Controller and Local I/O

The system menu provides the following status indications that are useful for troubleshooting and system
maintenance.

- Self-test results, diagnostics.

- RUN and OK status

- Network status and usage

- Average logic scan rate

- Application memory usage

- Loaded firmware versions

- Loaded protocols

- Removable media access

WARNING: Setting outputs ON in Do I/O mode can re sultin injury or cause machinery
to engage in an unsafe manner depending on the appl  ication and the environment.

13.3 CsCAN Network

For complete information on setting up a CsCAN network, refer to CAN Networks manual (MANO0799) by
visiting the Horner websites for the address to obtain documentation and updates.

Network status, node ID, errors, and baud rate in the controller system menu are all in reference to the
CsCAN network. These indications can provide performance feedback on the CsCAN network and can
also be used to aid in troubleshooting.

13.3.1 CsCAN Network Troubleshooting Checklist

1. Use the proper Belden wire type or equivalent for the network as specified in MANO799.

2. The RCC does not provide 24VDC to the network. An external voltage source must be used for
other devices such as SmartStix I/O.

3. Check voltage at both ends of the network to insure that voltage meets specifications of
attached devices.

4. Proper termination is required. Use 121-ohm (or 120-ohm) resistors at each end of the
network. The resistors should be placed across the CAN_HI and CAN_LO terminals.

5. Measure the resistance between CAN_HI and CAN_LO. If the network is properly wired and
terminated there should be around 60 ohms.

6. Check for duplicate node ID’s.
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7. Keep proper wires together. One twisted pair is for V+ and V- and the other twisted pair is used
for CAN_HI and CAN_LO.

8. Make sure the baud rate is the same for all controllers on the network.

9. Assure shields are connected at one end of each segment -- they are not continuous through
the network.

10. Do not exceed the maximum length determined by the baud rate and cable type.

11. Total drop length for each drop should not exceed 6m (20 feet). A drop may include more than
one node. The drop length adds to the overall network length.

12. Network should be wired in "straight line" fashion, not in a "star" pattern.

13. In applications requiring multiple power supplies, make sure the V- of all supplies is connected
together and to earth ground at one place only.

14. In some electrically noisy environments it may be necessary to add repeaters to the network.
Repeaters can be used to add additional nodes and/or distance to the network and protect the
signal against noisy environments. The Horner APG repeater is part # HE200CGM100.\

13.4 Removable Media - Basic Troubleshooting

Description Action

RCC does not read media card. Attempt to reformat MicroSD card on PC

Make sure the project file is saved as a .pgm file and not a
.csp file. In addition, to file must be .pgm, the file's /1O
configuration must match the RCC configuration for it to
download.

RCC will not download project file.

Table 19.2 — Removable Media Troubleshooting

13.5 Technical Support Contacts
For manual updates and assistance, contact Technical Support at the following locations:

North America:

Tel: 1-877-665-5666

Fax: (317) 639-4279
www.heapg.com

Email: techsppt@heapg.com

Europe:

Tel: (+) 353-21-4321-266

Fax: (+353)-21-4321826
www.horner-apg.com

Email: tech.support@hornerapg.com
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